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1 About this Document 

This manual provides detailed product related information, installation, configuration and 
operation instructions for 3DLevelManager software. The manual is designed for trained 
personnel. Please read it entirely and carefully before proceeding with installation of the 
product. 

1.1 Symbols in use 

The following symbols indicate different sections of additional information as 
follows: 

 

IMPORTANT: An indication for additional information, tips, hints or an indication 
of helpful additional knowledge. 

 

WARNING: Indication of a potentially dangerous situation, which could result in 
serious injury to persons and/or damage. 

1.2 For your safety 

Authorized Personnel 

All operations described in this manual should be performed by authorized and trained 
personnel only. For safety and warranty reasons, any internal work on the devices must be 
performed by manufacturer authorized personnel only. 

Appropriate Use 

The 3DLevelScanner™ is a device designed for continuous level or volume measurement. 
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Warning about Misuse 

Inappropriate or incorrect use of the device can give rise to application-specific hazards, 
e.g. vessels overfill or damage to system components through incorrect mounting or 
adjustment. 

General Safety Instructions 

The 3DLevelScanner™ is a high technology device which requires strict observance of 
standard regulations and guidelines. The user must take note of the safety instructions 
detailed in this manual, as well as country-specific installation standards, and all common 
safety regulations and accident prevention rules. 
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2 3DLevelManager™ Overview 

2.1 Overview 
The 3DLevelManager™ software is a configuration and monitoring tool for managing 

3DLevelScanner™ devices. 

The software supports various methods for connecting to the scanners, monitoring their 
measurement readings, configuring their various parameters, log results and produces 
various types of graphical reports. 

2.2 Features 
Major features of the 3DLevelManager software: 

 Supports HART, RS-485/Multi-drop, GSM, GPRS and TCP/IP communication 
interfaces to the linked scanners 

 Supports all 3DLevelScanner models (S, M, MV and MVL) in a single or multiple 
scanner arrangements 

 Easy to use wizard-based parameter configuration including graphical presentation 
and configuration aids 

 Various logging options and displaying log information as time-lined graphs 

 3-Dimensional, animated graphical presentation of filling/emptying processes 

 Built-in advanced analysis tools 

 Fully adaptable to user preferences (measurement units, display modes) 

2.3 System requirements 
The following minimum computer system characteristics are required for 3DLevelManager 
to install and run properly: 

Hardware: 

 Processor: Pentium 1GHz 

 Graphic resolution: Minimum 800x600 

 CD-ROM drive 

 Log file: 5MB/day 
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 At least one serial port (built in RS-232 / USB) 

Memory: 

 RAM: Minimum 64MB 

 Hard drive: Minimum 1GB free memory on HD per year (if log file is enabled) 

Operating systems:  

 Windows XP SP2 with Microsoft .NET Framework 3.5 SP1 and Windows 7 
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3 Installation 

 

3.1 Installing the software 
1 Insert the BinMaster software CD into the computer. 

2 Auto run should start automatically (if enabled in your computer). Otherwise, browse 
to the CD and execute the file BinMaster Level Scanner.msi. The setup wizard 
appears as shown: 

 

 

NOTE: If a previous version of the software is already installed on your computer, 
you will be offered with Repair and Remove options, for installing an updated 
version or completely uninstalling the software. 

3 Click Next to proceed with the installation. The following screen appears: 
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4 Press Browse to select a different installation folder if needed. 

5 You may allow other users of this computer accessing the software by selecting 
Everyone, or limit the access for yourself only by selecting Just me. 

6 Press Next to proceed.  

7 Press Next in the Confirm Installation window appearing next, to start the installation. 
Wait until the installation progress is complete: 

 

8 The software installation is in process, and all the necessary files are being installed in 
your computer. The following confirmation screen appears: 



 Installation ● Installing the software  

 3DLevelManager Operating Instructions © 2011 BinMaster all rights reserved 9 

 

9 BinMaster 3DLevelManager software installation is complete. Press Close to exit the 
installation wizard. 

 

Note the BinMaster 3DLevelManager shortcut icon which has been added to your desktop.  
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3.2 Understanding 3DLevelManager Basics 
The 3DLevelManager software is designed for both users and technical personnel. This 
chapter includes an overview of the user interface and general details regarding the two 
modes of operation. 

Connection Status 

Once a connection is established, the software downloads all parameters from the 
scanner. The download process may take a few seconds, during which the software will 
not respond and cannot be accessed. 

Once a 3DLevelScanner is connected to the computer running the 3DLevelManager 
software, a proper connection is indicated by a green light in the Connection Status field 
on the upper right side of the screen in the figure below. 
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Device Info 

The following device information is displayed on the upper part of the screen: 

 Electronic card serial number 

 Firmware version of the device electronic card 

 Hardware version of the device electronic card 

 Hardware interfaces supported by the device 

 Device type (S/M/MV/MVL) 

 Communication traffic load 

 Device polling address 

 

The Device Information area 

Measured Parameters 

The following device measured parameters are displayed on the 
right area of the screen as shown to the right: 

 Distance (tab): Average distance between the top of the 
scanner body and the material. 

 Min Distance: Minimum distance between the top of the 
scanner body and the material. 

 Max Distance: Maximum distance between the top of the 
scanner body and the material. 

 Level (tab): Average level between all echoes, measured 
from vessel bottom. 

 Min Level: The distance between the lowest measured 
echo to the vessel bottom. 

 Max Level: The level from vessel bottom to the material's 

highest point (equals Empty Calibration–Min Distance). 

 Volume: Material volume inside the vessel, in percent. 

 Mass: Material weight/mass inside the vessel (by user 
chosen units). A custom field which may display mass or 
volume data, according to the 3DLevelScanner 
configuration. 

 Temperature: Temperature level around the antennas 
inside the vessel. 

 SNR: Signal-to-Noise Ratio measured inside the vessel in 
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decibels (dB). The SNR indicates the scanner signal compared to the acoustic noise 
inside the vessel. 

 Output Current: 4-20mA analog output current. 

Technician Mode 

Technician mode allows configuration of advanced parameters which are not available 
under Viewer mode (the default operating mode). Switching to Technician mode requires a 
password. 

To switch to Technician mode, choose Tools → Technician Mode. You will be prompted 
with the Password Request box. Enter Technician mode password and press the OK 
button. The Technician mode password is techAPM, and it can not be changed.  

For Switching back to Viewer mode, select Switch to Viewer Mode from Tools menu (no 
password required). 

In Technician mode, there are 6 more tabs at the left area of the screen. These tabs allow 
viewing of parameters, modifying part of them and other useful tools such as False Echo 
Mapping, this document describes how to work in technician mode. 

Viewer Mode 

Viewer mode is the default operating mode of the software. This mode allows connecting 
and disconnecting the scanner, viewing log graphs, 3D image and performing basic 
grades analysis. Advanced parameters configuration is disabled for this mode.  

 

The 3DLevelManager in Viewer Mode 
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4 Connecting to 3DLevelScannerTM 

4.1 3DLevelScanner Connection Options 
The 3DLevelManager Software enables communication with 3DLevelScanner devices 
using different methods: RS-485, HART, GSM Modem, GPRS Modem and TCP/IP. 
Communicating using an RS-485 is much faster than GSM, GPRS or via a HART 
connection, therefore it is recommended to use standard RS-485 as communications 
infrastructure. 

Establishing a Connection 

Press Device → Manually Connect... (or, click the Reconnect button or press Ctrl+M) to 

initiate a connection between the 3DLevelManager and the connected scanners. This 
opens the connection box which lets you set the required communication properties and to 
establish a data connection between the software and the scanner. 

In the Connection Method field, select the communications interface used for connecting 
the scanner to the computer and the software. For detailed information regarding the 

communication options and settings, refer to page 33: Manually Connect… / Disconnect. 

 



Connecting to 3DLevelScannerTM ● 3DLevelScanner Connection Options  

14 3DLevelManager Operating Instructions © 2011 BinMaster all rights reserved  

 
RS485 Connection  
The figure below shows a schematic connection between a PC running the 
3DLevelManager software and a 3DLevelScanner, using an RS-485 connection. For more 
information about physical connections, refer to the BinMaster 3DLevelScanner Operating 
Instructions manual. 

 

RS-485 Connection 
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HART Connection 

When using an RS-232/USB HART Modem, no hardware installation is required. 

The figure below shows a local connection between a PC running the 3DLevelManager 
software and a 3DLevelScanner, using a HART modem connection. 

 

HART Modem Connection 

In this figure: 

1 RS-232/USB Connection 

2 3DLevelScanner 

3 HART Modem 

4 HART Resistor - 250 ohm, can be mounted on any of the 4-20mA lines 

GSM 

The GSM option enables a modem to modem communication. This type of connection 
requires a GSM modem connected to the scanner on one side, and a GSM modem 
connected to the computer on the other side. The user should have the telephone number 
of the modem connected to the scanner. 

GPRS 

The GPRS option allows IP connection to a remote 3DLinkPro with GPRS enabled. When 
selecting this option, a TCP port must be opened in the local network and be forwarded to 
the computer running the 3DLevelManager. On pressing Connect, an SMS message 
should be sent manually to the 3DLinkPro in the following format: 

CALLAPM,[external IP address],[TCP Port],[APN],  

A comma must end the SMS message. 
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TCP/IP 

The TCP/IP option allows converting and transferring the RS-485 data over TCP/IP using 
compatible converter. When establishing a connection to the TCP/IP converter, the local 
IP address and the TCP port values must be set to as defined in the converter. 

GPRS Using SMS Server 

This option creates a GPRS connection without the need to send an SMS message 
manually. A 3DLinkPro must be connected to the local computer running the 
3DLevelManager software in order to send the SMS message to the 3DLinkPro connected 
to the scanner. 

Multiple Scanner Connection 

When connecting several scanners in a Daisy-Chain, the 3DLevelManager can be 
connected to all scanners and specific scanner may be chosen to be viewed any time. For 
this type of connection, each scanner must be set with a different polling address. One 
scanner must be set with a polling address of 00. 

Using the Phonebook 

The 3DLevelManager stores a file named phonebook.txt which contains all connections 
and their properties. This feature can be used for GSM, GPRS or TCP/IP connection 
options.  

For viewing and editing the phonebook, select Browse to local folder from the File menu, 
and select the file 'phonebook.txt'. Each connection entry should start in a new line and 
with a different name. 
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5 First-time Configuration 

5.1 Configuration Wizard 
Use the 8-stage configuration wizard for first-time configuration of the 3DLevelScanner. 

 

NOTE: Prior to 3DLevelScanner configuration, verify that the 3DLevelScanner 
has the most recent firmware version installed. 

From the menu, select Tools → 
Configuration Wizard... (or press F4) 
to activate the wizard. 

 

 

 

The configuration wizard appears, starting at its first stage. During wizard navigation, the 
following options are available at any stage: 

 Click Previous to switch to previous stage. 

 Click Cancel to exit the wizard without completion. No parameter will be modified or 
saved to the scanner. 

 Click Next to continue to the next stage. 

Step 1/8: Set System Parameters 

Step 1 allows choosing device name and preferred measurement units. 

Set the device name/identity in the Tag Name field. This name is displayed on the 
scanner screen and in the software window title once the device is connected. The 
tag name field is limited to 16 characters. 

Choose the preferred distance measurement unit in the Distance Unit field. The 
available options are: meters, centimeters, millimeters, feet and inches. 

Choose the preferred temperature measurement units in the Temperature Unit field. 
The available options are: Celsius and Fahrenheit. 

Click Next. 

1 

2 

3 

4 
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Set System Parameters stage 

Step 2/8: Set Vessel Parameters 

Step 2 allows identifying the vessel geometry including with a specific shape for exact 
volume analysis. 

The vessel major parts (top, center and bottom) schematic geometry can be chosen and 
dimensions can be defined. 

Choose the proper shape for the vessel top from the Top Shape field. The options 
are: Flat, Cylinder, Dome, or Pyramid. Set the dimensions: 

 For a cone shape, set the height and the top diameter of the cone. 

 For a dome shape, set the radius of the dome. 

 For a pyramid shape, set the top section height, width and length of the vessel 
top at the X and Y directions. 

Choose the proper shape for the vessel center from the Center Shape field. The 
options are: Cylinder or Cube. Set the dimensions: 

 For a cylinder shape, set the height and the diameter. 

 For a cubic shape, set the height, width and length of the vessel according to the 
X and Y axis, respectively. 

1 

2 
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Choose the proper shape for the vessel bottom section from the Bottom Shape field. 
The options are: Flat, Cone, Dome, or Pyramid. Set the dimensions: 

 For a cone shape, set the height and the bottom diameter of the vessel bottom 
section. 

 For a dome shape, set the dome height. 

 For a pyramid shape, set the height, width and length of the vessel bottom 
section at the X and Y directions. 

 If the vessel shape is asymmetrical, for both cone and pyramid shapes, it is 
possible to set the bottom center as an offset from the entire shape center. The X 
Position and Y Position are the offset of the bottom section from the center. 

Click Next. 

 

Set Vessel Parameters stage 

Step 3/8: Set the Device Position 

This stage allows specifying the exact location of the scanner on the vessel. 

Set the device location according to the previously defined top vessel shape using 
one of the methods: 

 Drag the device on screen, or 

 Enter the X, Y and Z coordinates in Device Position fields at the top right corner. 

4 

1 

3 
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NOTE: It is possible to set the device Z position over the Z axis on the 
vessel ceiling, by clicking Set Device Z-Position to Ceiling. 

Click Next 

 

Set the Device Position stage 

Step 4/8: Set the Device View Point 

In this stage you have to specify the device mounting horizontal angle. 

The device should be mounted facing the center point of the vessel. For more information, 
refer to the BinMaster 3DLevelScanner Operating Instructions Manual. 

The following figure describes a schematic top view of the vessel and the scanner position. 

Based on the location of the scanner and its direction, set the Horizontal angle 
accordingly by positioning the scanner icon until the arrow points toward the direction 

of the coordinates center (0°) using one of the following methods: 

 Rotate the arrow icon until it points toward the 0° point, or 

 Press the Set Horizontal Angle Towards Center button, or 

 Input the degree value in the Device Horizontal Angle filed on top right. 

Click Next 

2 

1 

2 
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Set the Device Position stage 

Step 5/8: Set Filling Points 

This stage allows configuration of the vessel filling points. Up to 10 filling points may be 
defined. The following figure describes a schematic top view of the vessel and the filling 
point locations. 

Set the filling points using one of the following methods: 

 Bring the cursor to the desired location over the vessel top shape and left-click 
the mouse to set the filling point, or: 

 Press Add and enter the (X,Y,Z) coordinates in the Filling Points table and 
press Enter button. 

To edit a field: double click the field, enter the required value and press enter. 

To delete a filling point, mark the corresponding row and click Delete. 

To delete the full list of filling points, click Clear All. 

Click Next. 

1 

2 
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Set the Filling Points 

Step 6/8: Set Emptying Points 

This stage allows configuration of the vessel emptying points. Up to 10 emptying points 
may be defined. The following figure describes a schematic view of the vessel and the 
emptying point locations. 

Set the emptying point or points using one of the following methods: 

 Bring the cursor to the desired location over the vessel top shape, or 

 Press Add and enter the (X,Y,Z) coordinates in the Emptying Points table and 
press Enter. 

To delete an emptying point, mark the corresponding row and click Delete. 

To delete all the emptying points, click Clear All. 

Click Next. 

1 

2 
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Set the Emptying Points 

Step 7/8: Set Basic Settings and Linearization 

In this stage you can configure the vessel's basic settings. 

 Set the distance from the flange to the material 100% level (see figure below) using 
the Full Calibration field. 

 Set the distance from the flange to the material 0% level (see figure below), using the 
Empty Calibration field. 

1 

2 
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Empty and Full Calibration 

 

NOTE: The full and empty calibration levels determine the 100% and 0% 
accordingly and set the 4-20mA output current accordingly. 

 Set the process description: 

 Set the maximum emptying rate inside the vessel in the Max. Emptying Rate 
[tons/hour] field. 

 Set the maximum vessel filling rate in the Max. Filling Rate [tons/hour] field. 

 Set the vessel total material capacity in the Max. Capacity [tons] field. 

 

NOTE: The Max Capacity shown in this screen is used only for volume 
change rate calculation, based on the emptying/filling rate values. 

For example, setting the Max Capacity to 1000 tons and restricting the 
emptying rate to a maximum of 200 tons/hour and the filling rate to a 
maximum of 100 tons/hour. This results in material change rate of 10 hours 
to fill the vessel and 5 hours to empty the vessel. 

 Click Next. 

 

NOTE: When the 3DLevelManager is connected to 3DLevelScanner with 
FW version lower than 3.0.0, an additional two fields appear: Process 
Condition and Frequency. 

Process Condition – Not to be changed. The default value is standard. 

Frequency – Allows the selection between Low, Medium and High. The 
default value is Medium. 

  

3 

4 
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Basic Settings and Linearization 

Step 8/8: Set Advanced Linearization 

The last stage of the wizard allows configuring additional mass or volume to be displayed 
on the main screen and setting the linearization table of the vessel. The linearization table 
(also referred to as a strapping table) allows the scanner to convert the average Level 
calculation into Mass or Volume values. 

Linearization: Determines the mode: Linear, Custom Automatic or Custom Manually. 

Customer Unit: Sets the desired units. The available options are: Percent (%), m
3
, Liters, 

Tons, Gallons, lbs., ft
3
 or Bushels. 

Max Capacity / Density: The identifier shown is depending on the selected customer unit. 

 When selecting Linear mode, Max Capacity sets a maximum value, which 
represents 100% of the stored material. 

 When selecting Custom Automatic, the Density sets the density of the material in 
the case where Tons or lb. were selected in customer unit. 

Linearization: There are 3 linearization modes: 

 Linear: The output is set in reference to the material level and not to the volume. The 
measured volume is proportional to the measured material level (between full and 
empty calibration values), regardless the vessel shape. 

 Custom Automatic: Generates an automatic linearization table with a reference 
between the level and Volume/Mass, in percentage according to the vessel geometry 
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defined in step 2/8. The linearization table is being generated automatically according 
to the shape parameters (the table cannot be manually modified). When selecting one 
of the options, an additional field appears in the main screen of the software showing 
the calculated number, whether it is mass or volume. 

 Custom Manually: Allows manual entering of a linearization table values by the 
reference between the material level and the selected Customer Unit. The table can 
be populated with up to 32 points starting at 0, 0 and ending on the topmost level 
according to the requirement. The 3DLevelManager will display the Mass calculated 
according to the linearization table values only. 

 

NOTE: All Customer Units (%, m
3
, ft

3
, lb., Liters, Tons, Gallons, and Bushels) in 

all modes could be chosen and then displayed in the main screen of the program. 

The output is generated according to the linearization table produced at the 
selected Linearization mode. 

 

NOTE: Customer Manually  

The vessel shape is taken into consideration in the volume/mass calculation. 

Level points not included in the table are linearly calculated according to the 
level between the two nearest points. 

Although entering less than 32 points is possible, BinMaster recommends 
entering points as many as possible in order to increase measurement 
accuracy. 

With lb. units, the maximum weight entry allowed is 2,000,000 lb. 

Regardless of the mode, the output volume is presented in percents by default. When a 
different unit (other than percents) is selected, the volume/mass value is displayed under 
the volume (%). 

 Click Upload All to upload all configured wizard parameters to the scanner, or click 
OK to upload the parameters to the scanner and to close the wizard. 

If parameters were modified 
and not uploaded to the 
scanner, the following box 
appears (figure to the right) 
offering an option to upload 
all parameters to the device. 

 Click Yes to upload 
parameters to the 
scanner and to close 
the wizard. 

 Click No to close the wizard without uploading parameters to the scanner. 

 Click Cancel to close the window and stay in the wizard. 
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5.2 Advanced Configuration Parameters 
Following the completion of the configuration wizard of the 3DLevelScanner, open the 

advanced parameter window (press DeviceAdvanced Parameters…) in order to set 
general parameters such as Material Slope and Dumping Time. Other parameters may be 
configured and fine adjustments can be done at a later stage. Refer to page 29: Advanced 
Parameters for detailed instructions and descriptions. 

5.3 Grades Analysis 
Once configuration is done, a Grades analysis should be performed in order to view the 
returned echoes from the material surface and to use it to adjust the scanner. Refer to 

page 41: Analyze… menu for detailed instructions. 

5.4 False Echo Mapping 
In vessel installations with high sockets, struts or agitators, as well as with material buildup 
and welded joints on the vessel walls, can cause reflection interference which may result 
in erroneous measurements. The False echo mapping feature detects and marks these 
false echoes to be ignored during volume measurement. It is advised to generate the false 
echo mapping when the vessel is empty for detection of all potential interfering reflections. 

The false echo mapping feature is located under the Extended Calibration tab, and 
allows automatic scanning (enter a range to scan), manual scan (enter the range and 
threshold) and to reset all false echo mapping. 

5.5 Log Viewer 
The 3DLevelManager collects all data received from the scanner and stores it on the local 
computer hard drive. Selecting View→Log File... or pressing CTRL+W opens the logs view 

application. When a scanner is connected, the log graph starts building from the 
connection point. Browsing old logs can be done by pressing the browse button [...] and 
selecting the folder for viewing the log file contents. 

The logs are saved in HTML format and are stored in a folder labeled with the connection 
time and date. For more information, refer to page 37: Log File (Ctrl+W). 

5.6 3D Image Profile 
The 3DLevelManager is equipped with a highly useful feature of generating and displaying 
a 3-dimensional, graphical representation of the visual mapping contour of the stored 
material as scanned by the 3DLevelScanner MV and MVL models. For more information, 
refer to page 39: Visual Mapping. 
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6 Software Menus 

This chapter describes the different functions available under the software menus and sub-
menus options, ordered as they appear in the menu. 

6.1 File menu 

Load parameters for Browsing…  

Opens a saved parameters file (.APM file) for browsing only. Uploading to the scanner is 
not allowed. Shortcut key: Ctrl+B. 

Load Parameters to Device… 

Opens saved parameters file to upload to a connected scanner and for browsing. Shortcut 
key: Ctrl+D. 

Save Configuration… 

Saves all parameters (Basic settings, Safety settings, Linearization, Extended calibration, 
Output, Display, System Parameters, 3D Mapping and Advanced parameters) to an APM 
type file. You can choose the location and the file name to be saved. Shortcut key: Ctrl+S 

Browse to Local Folder… 

Open the local 3DLevelManager Application Data folder.  This folder includes different log 
files and grade analysis files. 

Generate a New Log File 

Stops storing data on current log file and generates new file with updated time and date 
stamp. A new log folder will be created under the installation directory, for storing log files 
with all data from the scanner. At least 2MB/day free hard drive space should be reserved 
for the logging activity in normal operation connection (not Verbose). 

Exit 

Exit the 3DLevelManager software. Shortcut key: Ctrl+X 
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6.2 Device Menu 
This menu allows accessing to advanced configuration options. Some of the menu options 
are disabled on Viewer mode, and become available under Technician mode. 

Advanced Parameters 

Opens the 'Advanced Parameters' box, where the algorithm parameters can be adjusted. 
This window is available under Technician mode only. 

 

The various fields can be downloaded or uploaded from/to the scanner. Any modified 
settings can be discarded using the Cancel button at the bottom.  

When connecting to a 3DLevelScanner with earlier firmware version (before v3.0.8), the 
Advanced Parameters window looks slightly different, as follows: 

 Output Dumping Time: Sets the history dump window time of the scanner. This 
parameter increases stability and improves the SNR. Default value: 300 seconds, 
minimum value: 60 seconds.  

 Steepest Material Slope: Set the maximum material slope. The scanner verifies all 
echoes for not exceeding the slope. Default: 35°. Recommended setting: between 30° 
to 45°. 
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 Offset: Sets the scanner installation offset distance from the mounting flange. 
Possible values are ranged at -1m (-3.28ft) to 1m (3.28ft). It is recommended to leave 
this value at 0m (0ft) and to set the offset in the configuration wizard, by manual 
setting the Z position of the scanner. 

When connecting to scanners with FW versions under 3.0.0, the three parameters above 
are set in the Extended Calibration tab in the main screen 

 Minimal SNR [dB]: The lowest SNR threshold. Below this level, the sensor does not 
measure and the reading remains unchanged. Default: 13dB. 

 Auto False Echo Recognition: Do not change this parameter. 

 False Echo Sensitivity: The minimum extra gain required to distinguish between real 
echoes and mapped false echoes. If false echoes prevent the device from tracking the 
true level, decrease the sensitivity. If false echoes are not ignored, increase the 
sensitivity. Default: 1.2 

 Restrain coefficient [%]: Sets the level of preference of echoes from shorter 
distances over echoes from farther distances. 100% = no preference of closer echoes. 
0% = total preference of the first echo. Default: 10% in FW lower than 3.0.0, 12% in 
new FW. 

 Side Margins [m/ft]: Allows tolerance in echo recognition to the sides of the vessel 
(see figure).  

Used for creating a tolerance in case of unknown vessel width/diameter, and when a 
tolerance is required for detecting points from the sides of the vessel.  

Echo within the tolerance/margin range is transformed to the side of the vessel on the 
X-Y plane and will not be eliminated in calculation. Default: 1m (3.28 ft.). 

 Bottom Margins [m/ft]: Allows adding a tolerance in echo recognition from the bottom 
shape (but not flat) (see figure).  

This is used for creating a tolerance in the case of unknown vessel dimensions, and 
when a tolerance is required for detecting points from the bottom of the vessel. 
Default: 1m (3.28 ft.). 
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 Top Dead Band [Discard/Don’t Discard]: To be used only when canceling echoes 
with a mapping range for short distances is not possible. The unit discards all echoes 

up to the full calibration. Default: Don’t Discard. Discard: The sensor scans material 

only at a distance larger than full calibration distance. Don’t Discard: Distances 
smaller than full calibration distance are scanned as well. If measured distance to the 
content is smaller than full calibration, the full calibration distance is presented. 

Historic Log Sampling Period: Sets the interval between measurements that are 
saved into the local memory. By default, the scanner does not store the log. The 
settings are ranged between 1 to 60 minutes. If the scanner has been reset due to 
powering off or via the software, this parameter resets to its default value and the log 
will not proceed with data accumulation. When connecting to a scanner of an older 
FW version, the following advanced parameters are available. The following 
descriptions refer to parameters which were not mentioned above. 

 

 Activate Extrapolation [Yes/No]: setting the scanner to 'Yes' activates extrapolation 
where volume calculation is based on the entire surface. A 'No' setting causes the 
scanner to calculate the volume based on the mapping points received. Default: 'No'. 

 Max Emptying Rate [tons/hour] (The maximum emptying rate), Max Filling Rate 
[tons/hour] (The maximum filling rate) and Max Capacity [tons] (The total capacity of 
material within the vessel) are set in the Configuration Wizard step 7/8. 
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 Window Size [m/ft]: Not to be changed in FW version earlier than 3.0.8. Default 
value is 100m (328ft). 

 Good SNR [dB]: The threshold of the good SNR. Above this level, the sensor 
increases its measurement speed. Default: 18dB. 

 Exceeding Filling Rate After Echo Loss [Yes/No]: Don't Discard / Discard tracking 
rates following a long echo loss. This function enables faster recovery to correct 
volume reading following a long period of echo loss. Default: Yes. 

 Use Compressed Pulses [Yes/No]: Default: Yes. Pulse compression starts 
functioning for distances larger then 9m (30ft) (in versions earlier than 3.0.0). 
Activating this feature allows a better resolution. It is recommended to set the Auto 
False Echo Recognition to 0 when the pulse compression is on. 

 Download All: Downloads all parameters from the scanner to the software. 

 

NOTE: There are three ways for downloading all parameters from the device: 
using the Main Screen, using the Device menu and using this Advanced 
Parameters window. 

 Upload All: Upload all parameters from the software to the scanner. 

 

NOTE: There are four ways for uploading all parameters to the device: using 
the Main Screen, using the Device menu, using this Advanced Parameters 
window and using the last step of the wizard. 

 Cancel: Close the Advanced Parameters windows without up/downloading from/to the 
scanner 

Figure Properties 

These parameters define the settings for the 3-Dimensional 
image. 

 Matrix Size: default: 50. Defines the X, Y matrix. A value 
of 50 (X and Y = 50) means 2500 resolution points. A 
larger value requires many more points and more 
computer resources to generate the 3D image. 

 Filter Size X, Y: default: 60%. The 3D image of the 
material surface is generated using a mathematical 
algorithm which takes each creates a cone around each 
echo received. Each cone is calculated and summed with 
its neighboring cones. The filter determines the cone 
width to be used for the calculation. 

 HX, HY: default: 25%. Determines the widening of the 
cone described above. 
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NOTE: It is recommended to leave the values at their defaults. Modification of 
these values should be done with understanding the implications of each 
modification on the resulting output. 

Manually Connect… / Disconnect 

Opens the connection box which allows setting the required link and communication 
properties and to establish a data connection between the software and the scanner. 

In the Connection Method field, select the 
communications interface used for connecting the 
scanner to the computer and the software. The 
available options are: 

 HART: The scanner is connected using a HART 
modem. 

 Select the serial COM port number the 
HART modem is connected to, and enter the 
scanner polling address. 

 Click Connect. 

 RS485: Connection over RS-485 bus. 

 Select the serial COM port number the RS-
485 Converter is connected to, and enter the 
scanner polling address. 

 Click Connect. 

 

 GSM (Modem): The scanner is connected using a local GSM modem. 

 Select the serial 
local COM port 
number and enter 
the scanner 
polling address. 

 At the right pane, 
enter the site 
name and the 
phone number of 
the other side 
modem. 

 Click Connect. 
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 GPRS: The scanner is connected through the internet over GPRS using 3DLinkPro. 

 Enter the local IP port number and the scanner polling address. 

 Click Connect. 

 Send an SMS message to the scanner to initiate the connection. 

 GPRS + SMS: The scanner is connected via the internet using 3DLinkPro. The link 
uses SMS messages over a local GSM modem connected to the computer. 

 Select the serial port of the 3DLinkPro connected to the computer. 

 Select the scanner polling address. 

 At the right pane, enter the site name. 

 Set phone number of the 3DLinkPro connected to the scanner. 

 Set the computer local IP port. 

 Set the external IP address (usually the router IP address). 

 Set the APN word of the 3DLinkPro connected to the scanner. 

 Click Connect. 

 

 TCP/IP: The scanner is connected via a TCP/IP network to an RS-485 connection. 

 Select the scanner polling address. 

 In the right pane, set the site name. 

 Set the Server IP address and IP port number. Server IP is the device converting 
RS-485 to TCP/IP. 

 Click Connect. 

 Polling Address: Enter the scanner polling address when connected via daisy-chain 
connection (RS-485 Multi-drop). Address range: [00 to 63 or Multiple]. When selecting 
Multiple, each scanner must have its own, unique address. 
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Disconnect 

Disconnect software communication to the device. 

Polling Address Selection 

Use the dialog box to set polling address of 
multiple 3DLevelScanner scanners to be 
monitored using an RS-485 Multi-drop 
connection. 

Check the check-boxes with the polling 
address per each scanner to be monitored. 
Log files will accumulate data for all selected 
scanners. 

 Normal Scanning scans all the 
selected scanners. This is the default 
value and should not be changed. 

 

 

 

NOTE: The scanning option parameter selection on top-right exists only on older 
software versions, and should not be modified. 
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Update Firmware 

Uploads a new firmware to the 
device electronic card.  

 Click the […] browse button to 
select the APM file (*.ldr) to 
upload to the device. 

 Click Start Update to upload the 
file to the device. 

 Click Cancel Update to stop the 
update process. 

 Click Close to close the window. 

 

 

 

IMPORTANT: Once the firmware update process is complete, reset the device to 
factory settings by clicking Reset to Factory Settings in the Advanced 

Parameters – Cont. screen, described in page 29). When using software version 
3.0.0 and above and upgrading to FW 3.0.8 and above, it is not necessary to 
reset the device to factory defaults since all settings are done automatically. 

Downgrading a scanner firmware from version 3.0.0 and above to older versions 
such as 2.9.843 is not recommended. On such downgrading, the scanner will 
return to its factory defaults and an upgrade to the original version will be 
necessary. Please contact BinMaster support when facing such requirement. 

Upgrade/Downgrade 

Upgrades or downgrades between S, 
M and MV versions. 

 Select the relevant type to be 
upgraded to. 

 Click OK. 

 A password is required for 
upgrading to a higher type 
(M/MV). The password can be 
supplied by your local distributor 
as a text file, or acquired from 
BinMaster. Copy the password 
from the text file (license number) 
into the empty field in the dialog box. 
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Note: Once the upgrade process is complete, the device will automatically reset 
and initialize itself. 

Device reset 

Resets the device. The initializing process takes about 30 seconds. The scanner will 
perform a new search for the correct measurement. 

 Restart Scanner: sends a restart command to the scanner. The internal DSP will 
boot and start building the auto false echoes and dumping values. 

 Reset to Factory Defaults: Resets all system parameters to their default factory 
settings, and resets the 3DLevelScanner resets. All the parameters must be re-
defined following this operation. 

 Reset Advanced Parameters: Reset all advanced parameters, available only with 
firmware versions above 3.0.0 

6.3 View Menu 

Log File (Ctrl+W) 

Loads a log file and displays graph presentation.  

 The Log option displays 
charts for Distance (m/ft), 
Volume (%), SNR (dB) and 

Temperature (°C/°F) over 
a time line as shown. Log 
files are saved as the 
connection is established. 
The files are saved in a 
local folder. 

For viewing older log files, 

press the […] browse 
button. A browsing window 
opens, showing the Logs 
folder for choosing a 
different log file. The file 
names include the date 
and time of the connection. 

Log File graph representation 

 

In Multiple Mode, the software monitors all the scanners selected in the Polling Address 
Selection (see page 35). For viewing a different scanner log file, select the scanner 
Polling Address in the drop-down list at the top-right corner. 
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Use the preference menu for displaying logs in different distance units (m, cm, mm, ft., 
inch), different temperature units (Celsius, Fahrenheit), different time zone (hours 
difference) and different regional settings (using dots or commas as digit separators). 

Historic Log… 

The scanner allows storing logs in its local memory. Use the Historic log settings in the 
Advanced Parameters feature to enable this option. To view the log from the scanner 

memory, select the Historic Log… option. 

When selecting the Historic log, a box appears asking for selection of the required log time 
to be retrieved from the scanner. Once download is complete, a log viewer window opens 
displaying the logs. The log data is then saved under the Historic log folder. 

 

 

Note: This option allows choosing a 3D Log option which creates a 3-
Dimensional representation of the log. This option is not available under 
Technician Mode. 

Communication Log File… 

The Communications Log File contains logged data corresponding to the communications 
between the software and the scanner connected to it. Selecting this option opens the file 
in an Internet browser window. The file format is HTML and it might be required for tech 
support use. 

Communication History… 

The Communications History contains logged data corresponding to the communications 
events between the software and the scanner connected to it. Selecting this option opens 
the file in an Internet browser window. The file format is HTML and it might be required for 
tech support use. 
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Linearization Info 

Outputs a graphical representation of the linearization line of the vessel as configured in 
the Configuration Wizard, which represents the volume/mass related to the level (as 
displayed in step 8/8 in the wizard, page 25). In addition, the scanner divides the vessel 
into 32 points, assigning each point with a level and a corresponding volume/mass value. 
The points table is displayed to the right of the graph (see figure below). 

This window is for reference only. All changes can be done in the Configuration Wizard 
step 8/8. 

 

Linearization table 

Visual Mapping 

Generates and displays a 3-dimensional graphical representation of the visual mapping 
contour as scanned by the 3DLevelScanner MV or MVL. 

The legend scale to the right side displays the measured level. 

 To rotate the 3D image, press and hold the mouse left key and drag over the image at 
the desired rotation direction. 

 The Manager application generates 3D mapping frames depending on the connection 
rate. To watch the animation, click Watch Log, a new 3D image and a browse 
window opens. Select the desired log folder, located under the Logs folder. Use the 
video controls to play, stop, move backward or forward or scroll along the time line. 
The interval (msec) sets the frame time interval. The minimum value is 1msec. 

 For switching between a zoomed-out view of the silo and a zoomed-in view of the 
material surface, click the top right button or double-clicking the 3D image itself. 
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Visual mapping window 

Right-click the mouse to open the additional features menu: 

 Show legend: Displays the level scale on top right corner. 

 Show Material Surface Only: Displays the surface of material only. 

 Show Vessel Geometry Only: Displays the vessel geometry without material. 

 Show Device, Fill, Empty points: Displays the device, filling and emptying points 
relative to the vessel geometry. 

 Material Color…: Choose a desired material color.  

 Show Axes: Displays the x-y-z axes. 

 Activate Pan Mode: Switch from image rotation to panning. 

 Save Image As…: Performs a screen capture of the entire window. 

 Misc: Opens a sub-menu with the following options: 

 Show Silo Dimensions Wall: Displays a grid with dimensions, same as with the 
zoomed in image. 

 Draw Silo Grid (Wireframe): Displays a wireframe over the material surface. 
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 Show Solid Material Color: Displays the material in a solid color. 

 Fill Bounds with Material: Shows the complete material around the surface, or 
the surface only. 

 Hide Top Shape: Hides the top part of the vessel (if not flat). 

 3D Algorithm Accuracy: Controls the number of points in the image. Available 
options are: Normal, Good and Best. The default option is Normal. Changing the 
option is not recommended, since such change will consume most of the graphic 
card resources. 

 View: Opens a sub-menu with different viewing angle options. 

6.4 Tools Menu 

Configuration Wizard (F4) 

The configuration wizard provides a wizard-based, graphical-aided tool for configuring a 
connected 3DLevelScanner. At the first run after software installation or following a new 
scanner connection, all wizard steps must be followed and all parameters should be 
configured according to the Installation Preparation Form (IPF) filled prior to the installation 
and approved by the BinMaster Customer Support or by your local distributor. 

Refer to page 17: Configuration Wizard for a detailed description regarding the 
configuration wizard. 

Analyze… 

The Analyze tool allows a selection of 
different signal types downloaded 
from the scanner at a preferred time 
resolution and generates a chart-type 
report for each scan. On choosing 
this menu option, the following box 
appears:  

 Select All Grades Info or 
Grades or False Echoes to 
analyze the scanner behavior in 
the vessel. 

 Click Start to begin the analysis 
once the desired options are 
checked. The analyze tool will 
then start downloading the 
signals from the scanner. This 
stage takes a few seconds or 
minutes to complete, depending on the communication speed. Once completed, the 
analysis results window appears. 

 Click Cancel to stop the download. 
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 Click Close to close the Analyze… window. 

 Click Load From Files and select the file from the appropriate folder for uploading a 
certain signal (channels, grades, or false echoes). 

All Grades Info: Checking this option causes the analyze tool to download the 
Grades, Grades Threshold (controlled by an automatic algorithm), False Echoes and 
Auto False Echoes. The files are saved under a separate folder named with the tag 
name, date, and time. Note that when checking this option, the rest of the options 
cannot be selected. 

 Grades: Checking this option causes the analyze tool to download all the echoes 
received by the scanner (energy values returned from each object in the vessel). The 
file is saved under a separate folder, named with the tag name, date and time. 

 False Echoes: Checking this option causes the analyze tool to download all false 
echoes mapped under the False Echoes Mapping. This reveals the strength of each 
false echo at each distance. The file is saved under a separate folder, named with the 
tag name, date and time. 

 Continuous Grades: This feature allows running the grades analysis continuously for 
later viewing of the changes in material and scanner behavior over time for an in-
depth analysis. The Continuous Grades feature is also possible with all scanners 
connected in multi-drop connection. Use the Every field for setting the pause interval 
between two scans, the minimal value is 3 minutes between scan stop to new scan 
that starts. 

Channels / Raw Data: Checking this option causes the analyze tool to download the 
nine signals returned to the transducers. Enter the maximum scanning range in the 
Max Range field. All files are saved under a separate folder, named with the tag 
name, date and time. 

The Raw Data option is to be used only when an BinMaster Technical Support 
personnel requires this operation. This feature is intended for engineering use only. 

 

NOTE: A multiple selection of the Grades, False Echoes and 
Channels/Raw Data options can be made, by checking the desired signal 
type to download. In such case all files are saved under the same folder 
(named with the tag name, date and time). 

NOTE: Measurements are freezing during the raw data extraction process. 

NOTE: Grades and False Echoes functions are compatible with FW 
versions prior to 3.0.0. 
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All signals output result charts 

The above analysis result charts represent a single beam analysis and all-beams 
analysis. 

The X axis represents the distance from the device flange. 

The Y axis represents a grade parameter assigned to each echo by the algorithm. 
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The echo signals for the different beams are presented with lines of different colors. 
Unchecking a beam/feature at the legend box to the right hides the corresponding 
beam or characteristic. 

Communication Quality Test 

Analyzes the connection quality of the RS-485 cable 
connected between the computer and the scanner. If 
packets not answered, or received with errors, the 
cable must be checked for existence of proper resistors 
on both sides and verified to be of shielded and 
twisted-pair type.  

An example for a good test result: an averaged delay of 
97msec (very low), no lost packets and no errors 
received.  

 Click Restart Test to restart testing. The test will 
cycle through until terminated. 

 Click Close to terminate and close the window. 

Switch to Viewer Mode 

Switching to Viewer Mode disables parameter modifications. Switching from viewer mode 
to technician mode requires a password. 

Senior Technician Mode 

Switch to Senior Technician Mode allows advanced parameter changes. Switching to 
senior technician mode requires a password. 

Working with the Graphs 

Zoom-in, zoom-out and pan options are available for all charts created by the 
3DLevelManager: Grades Analysis, Log and Historic log. 

 Zoom-In: Choose a rectangular area you wish to zoom in and place the mouse cursor 
on the top left corner of it. Left click the mouse and drag it to the bottom right corner of 
the required area, making sure not to release the mouse button until the entire 
required area is selected. 

 Zoom-Out: Place the cursor of the mouse inside the graph, left click the mouse and 
move it from bottom right to top left and release the mouse button. 

 Pan: Right click the mouse button and hold it inside the graph area. While moving the 
mouse, the graph will pan to the sides. 

 Back to default view: In the Grades Analysis window, double clicking the graph will 
pop up a window asking to confirm the reload of the data. 
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7 Advanced Functions 

7.1 Firmware update 
Upload a new firmware to the 3DLevelScanner. For instructions, refer to page 36: Update 
Firmware. 

7.2 Model Upgrade 
Upgrading or downgrading the 3DLevelScanner model between S, M and MV versions. 
For instructions, refer to page 36: Upgrade/Downgrade. 

7.3 Continuous Grades 
This feature allows running the grades analysis continuously for later viewing of the 
changes in material and scanner behavior over time, for an in-depth analysis. Usage is 
also possible with all scanners connected in multi-drop connection. Use the Every field for 
setting the pause interval between two scans and check the Enable Multidrop box. For 
more details, refer to page 27: Grades Analysis. 

7.4 View Multiple Logs - Log Viewer 
When connecting to the scanner or to scanners connected in multi-drop, a new folder is 
created containing all data from the scanners. The 3DLevelManager allows viewing of 
multiple log folders at once. For viewing multiple logs, create a specific folder with a unique 
name, and copy all required folders to the new folder. Open the Log Viewer (Ctrl+W), 
press the browse button [...] in the log viewer application and browse for that folder. When 
selecting the folder, the log viewer starts displaying the logs data. Wait until loading is 
complete. 

7.5 Historic Log 
For retrieving and viewing stored logs data from the scanner, select View→Historic Log. 

The Historic log contains historical scanner activity data. The Historic log feature must be 
activated in order to view its contents. For activating the Historic log, select from 
Advanced Parameters the period between two stored logs. The options vary from 1 
minute to 60 minutes. Allow storing the log between 3 days to 180 days accordingly. 
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In the Historic log window, select Log and press Start, or select log and Partial log, set the 
number of days and hours calculated back from the current time. Performing partial log 
may be faster than trying to receive all data. 

7.6 Play a 3-Dimensional Movie 
The Visual Mapping feature allows building and viewing a movie based on the generated 
3D representations as frames. When activated, a player window opens for selecting the 
desired log folder for generating the movie.  

The 3D movie feature works only with MV or MVL scanner model logs, refer to page 39: 
Visual Mapping. 

7.7 Using the Tabs 
In technician mode, there are 6 tabs available on the main software screen: 

 Output: the Output tab is designed to control the 4-20mA output signal, in this tab 
there are two functions: 

 Simulation: Simulating of the output current can be changed by Level (m), 
Volume (%), or current (mA). This feature is useful for synchronizing the PLC and 
verifying of identical read values for both the scanner and the PLC. When the 
simulation is on, a red blinking signal appears, indicating: Simulation is Active. 

 Current Output Mode: Allows setting the output to send the standard 4-20mA 
signal or optionally to send a reverse signal: 20-4mA. The last option sets the 
scanner to output a fixed value. 

 

NOTE: Notice the simulation indicator which is shown when the simulation 
is active. 

 Display: Allows setting the 3DLevelScanner onboard display. It allows setting the 
Back to Home time (default: 300 seconds), the Number of Digits to display after the 
decimal point and turning the display off. 

 System Parameters: Read-only. Settings are allowed in the configuration wizard's 
first step. 

 Basic Settings: Displays the full and empty calibration levels, which can be set in 
step 7/8 in the configuration wizard. 

 Linearization: Displays the settings of the linearization as configured in step 7/8 in 
the configuration wizard. 

 Extended Calibration: Allows viewing the Output Dumping Time, Offset and 
Steepest Material Slope (in firmware versions lower than 3.0.0, these fields can also 
be changed). 

 False Echo Mapping: refer to page 27: False Echo Mapping. 
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Appendix A: End-User License Agreement  

Terms of Use & End User License Agreement 
This is a legal agreement between you, a user or purchaser of the Product (defined below) (the 
"End-User" or "You"), and A.P.M Automation Solutions Ltd. ("APM") regarding the software 

program accompanying this agreement and is a part of the 3DLevelScanner product of APM 
purchased by you (the “Product”), including the APM proprietary software program embedded in 
the Product (the “Software”), the hardware APM proprietary components of the Product (the 
"Hardware") and the Documentation (defined below). By opening the envelope in which the 
Software is provided and/or the package in which the Hardware is provided, by installing or by 
using the Software and/or the Hardware, You agree to be bound by all the terms of this Terms of 
Use & End User License Agreement (the "Agreement"). If You are obtaining an update of the 
Software from APM, then the term Software also includes, and the terms and conditions of this 

Agreement also apply to, any pre-existing Software and data provided within earlier Software 
releases, to the extent such earlier Software and data is retained by, embodied in or in any way used 
or accessed by the upgraded Software provided with this Agreement. APM IS WILLING TO 

SELL THE PRODUCT AND TO LICENSE THE SOFTWARE FOR OUR USE ONLY ON 

THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS 
AGREEMENT. If You do not agree to the terms of this Agreement, then please return the 

Product and the Software and any accompanying items to the place from which you obtained 

them. 

 

1. License. APM grants to End-User, a non-exclusive, non-transferable, non-sublicensable, personal 
license to install and use the Software for internal use by End-User at the site in which the Product 
was installed, together with the Hardware, and to use the text material that describes the design, 
functions, operation, and use of the Software (the “Documentation”) in support of End-User’s 
authorized use of the Software. 
 
2. Copy Restrictions. The Software, the design of the Hardware and the Documentation are 
protected by intellectual property laws and international treaty provisions. Unauthorized copying of 

the Software, the design of the Hardware and/or the Documentation, in whole or in part is expressly 
forbidden. Subject to these restrictions, End-User may (i) load the Software onto computer servers 
to support authorized use, and (ii) make one copy of the Software solely for backup, archive and 
disaster recovery purposes, provided End-User includes all copyright and trademark notices on the 
back-up copy. End-User may not copy any part of the Documentation, nor modify, adapt, translate 
into any language, or create derivative works based on the Documentation, the Software and/or the 
Hardware, without the prior written consent of APM. 
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3. Ownership of the Software. APM retains all right, title, and interest in the Software, the design 
of the Hardware and the Documentation and any copy thereof, and reserves all rights not expressly 

granted to End-User. This License is not a sale of the original Software or of any copy thereof. 
 
4. Use Restrictions. (A) The Software is licensed to End-User for its own use only. The Software 
contains copyrighted material, trade secrets, and other proprietary materials of APM. End-User 
acknowledges that the scope of the license granted hereunder do not permit End-User (and End-
User shall not allow any third party) to: (i) decompile, disassemble, decipher, reverse engineer or 
attempt to reconstruct, identify or discover any source code, underlying ideas, design, underlying 
user interface techniques or algorithms of the Software and/or the Hardware, by any means 

whatsoever, or disclose any of the foregoing; (ii) provide, distribute, rent, lease, lend, use for 
timesharing or service bureau purposes, or otherwise use, transfer or allow others to use the Product 
for the commercial or other benefit of third parties whether or not for consideration; (iii) modify, 
incorporate into or with other software, or create a derivative work of any part of the Software 
and/or the Hardware; (iv) disclose the results of any benchmarking of the Software, or use such 
results for its own development activities, without the prior written permission of APM; (v) attempt 
to circumvent any user limits or use restrictions that are built in to the Product; or (vi) sublicense, 
transfer or assign this Agreement or any of the rights or licenses granted under this Agreement and 

any attempt to do so shall be of no effect. End-User shall not remove, obscure, or alter APM's or 
third party suppliers’ copyright notices, trademarks, or other proprietary rights notices affixed to or 
contained on or within the Software. 
 
(B) For ATEX Compliant Products only: The Product is an ATEX compliant product. THE 

REMOVAL OF ANY COMPONENT OR THE ATTEMPT TO USE THE PRODUCT OR 

ANY PART THEREOF COMBINED WITH ANY NONATEX COMPATIBLE 

COMPONENT OR BY USE OF THE PRODUCT WITH ANY PART FROM A NON-ATEX 

COMPATIBLE COMPONENT OR WITH A COMPONENT THAT WAS NOT SUPPLIED 

WITH THE PRODUCT BY APM, MIGHT CAUSE DAMAGES TO THE PRODUCT, 

EXPLOSIONS, FIRE, DAMAGES TO OBJECTS IN THE VICINITY OF THE PRODUCT 
OR BODILY DAMAGES TO PERSONS IN THE VICINITY OF THE PRODUCT. 
 
For non-ATEX Compliant Products: The product is not ATEX compliant. The use of any part 

of an ATEX compliant Product with non-ATEX compliant Product constitutes infringement 

of the provisions of Section 4(A) above, and does not make in any way the non-ATEX 

compliant Product into an ATEX compliant Product, and MIGHT CAUSE DAMAGES TO 

THE PRODUCT, EXPLOSIONS, FIRE, DAMAGES TO OBJECTS IN THE VICINITY OF 

THE PRODUCT OR BODILY DAMAGES TO PERSONS IN THE VICINITY OF THE 
PRODUCT. 
 
 

 



Operating Instructions

Find all of your level
measurement needs at:
www.binmaster.com
>  SmartBob2 weight & cable
>  Rotaries
>  Capacitance probes
>  Vibrating rods
>  Diaphragm switches
>  Tilt switches
>  Ultrasonics
>  Radar
>  Aeration

Call us for dust & flow detection devices, too!

 

Shipping Address:
7201 N. 98th St.

Lincoln, NE 68507  

Mailing Address:
P.O. Box 29709

Lincoln, NE 68529

800.278.4241  |  402.434.9102
Fax: 402.434.9133

www.binmaster.com  |  info@binmaster.com

Featuring APM
Automation Solutions

Ltd Technologies
(patent pending)

©2011 BinMaster Level Controls. All rights reserved.
Information in this document is subject to change without notice.

 

www.hvssystem.com

Siège social :
2 rue René Laennec
51500 Taissy
France

Contact : 
hvssystem@hvssystem.com

Tél : 0326824929
Fax : 0326851908

Distribué par :


